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Apresentacgdo do PLD Altera D2-115

* Video 1: PLD
https://www.youtube.com/watch?v=aPXMKkTJxD s

* Video 2: Fabricacdo de memodria flash
https://www.youtube.com/watch?v=KdabXrTOXJc

*\/ideos acessados em 01/03/2015
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PLD D2-115 da Altera

O que é um PLD?

E um dispositivo légico programavel (Programmable logic device - PLD) utilizado
para construir circuitos digitais.

Ao contrdrio de uma porta légica, que tem uma fungdo fixa, um PLD tem uma fungdo
indefinida quanto a sua fabricagdo. Antes de se utilizar um PLD num circuito, este
deve ser programado (via linguagem ou via esquematico).
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PLD D2-115 da Altera

Como o PLD guarda a configuragao?

Um PLD é uma combinagdo de dispositivos légicos e de memdria. A memoria é
usada para guardar o padrdo que é dado ao chip durante a programagdo. Muitos dos
métodos para armazenar dados no circuito integrado foram adaptados para serem
usados em PLDs. Isto inclui:

SRAM

Células EPROM, EEPROM

Memoria Flash

PLDs baseadas em SRAM tem que ser programadas cada vez que a energia é ligada
isto normalmente é feito por outra parte do circuito. Uma célula EPROM é um
transistor MOS (semicondutor de 6xido metalico) que pode ser comutada por uma
carga eléctrica permanente aplicada no seu eletrodo 'gate'. Uma mem©ria FLASH é
ndo-volatil, retendo a informagdo mesmo que a energia elétrica seja desligada.

’ iiotod

A
Aula 2

PLD D2-115 da Altera
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PLD D2-115 da Altera
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¢ Questio: Como transformar o projeto de um sistema digital
(normalmente representado por um desenho contendo um conjunto de
simbolos logicos interligados) em um circuito fisico real, implementado
com Circuitos Integrados (CI’s)?
Utilizaremos como exemplo o circuito logico de alerta de abertura do
cinto de seguranca, representado na figura seguinte.

Belt Warn

IC

(a) Digital circuit (b) Physical
design = _ o coma iMplementation
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Sistemas
Digitais
SSI / MSI - Circuitos ASIC’s - Circuitos de
de Logica Padrao Aplicacao IEspectﬁca %\
ITI Totalmente Células Matrizes
L8 e 10 Personalizado || Padronizadas|| de Portas

Fonte: R. Tocci

Critérios de sele¢io de tecnologias:

* custo de fabricagao; * complexidade do sistema:
» tempo de projeto e de fabricacio; * desempenho (fempos de atraso);
* volume de produgéo; * tamanho do circuito;
» disponibilidade estratégica; * consumo de energia;
* seguranga industrial, « facilidade de teste e manutencao.
i¢
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PLD (Programmable Logical Devices) caracterizam-se por permitir ao projetista
configurar as células logicas do CI de modo adequado a atender ao projeto, sem a
necessidade de fabricacdo de componentes especiais.

Tipos de PLD:

* SPLD (Simple Programmable Logic Devices): circuitos com centenas de portas
logicas basicas (AND e OR) e eventualmente registradores, que podem ser
interconectadas pelo projetista através de ferramentas de configuragio de
hardware;

CPLD (Complex Programmable Logic Devices): circuitos com centenas de
elementos logicos (cada um deles similar a um SPLD). que podem ser
configurados individualmente e interconectados pelo projetista afravés de
ferramentas de configuragdo de hardware;

FPGA (Field Programmable Gate Arravs): circuitos com centenas de blocos
logicos programaveis individualmente, atraves de blocos de memoria (tabelas de
consulta), que podem ser interligados afraveés de uma matriz de chaveamento,
também programavel pelo projetista através de ferramentas de configuracio de
hardware.
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FPGA (Field Programmable Gate Arrays): circuitos com centenas de blocos
légicos programaveis individualmente, que podem ser interligados através de
uma matriz de chaveamento.
S| =1 =1 =1 =]
L9 o= : ‘ o
Exemplo de o & Biooe 1 [ oocs l Bioos
= . = e logico —| logico |[—+ logico
arquitetura de EERE Ny I = e
um FPGA — hE— | T_ ' :
o _é' oT [es — T"‘-m ..... ::)
I | Bloco ! Bloco Biloco
Ibgico |t Ibgico légico
2_ clk clk clk
o T T T
L -}
Bloco Bloco Bloco
o légico i logico Igico
clk clk clk
JL ' N dLb
O  Interconexio programével NOTA: As entradas de clock
— Sagmento de conexao podem ter caminhos
- Caminho para interconexdo Fonte: R. Tocci ?;f;’na‘a:‘; :; :;'i‘:mggﬁﬁﬂ
* P4g. 486 TOCCI, 112 edigéo n kroton®
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Resumo da organizacao logica de um FPGA:
Bloco de Meméria (LUT) + FF + MUX = CLB (Blocos Ligicos Configuraveis)
ab Seleet
SRAM Cells f0ra) SRAM cell
b«
o 00 0 out
n_’ s fab) 01 1 = In,
n—,m 10 1 LA Lt
11
b—-
Switch Matrix
(Matriz de
Interconexdes)
10B
(Blocos de
Entrada e Saida)
i¢
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A . Correcio de Erros
S = Particionamento
¢ =
=
E § Descricio
=
X (Esquema/ HDL) Simulacio

HDL /RTL
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Funcional

Transposicio
Mapeamento

Posicionamento
Roteamento

Processo
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* Principais Fabricantes:
— ALTERA

» FPGA: Cyclone II - [EZi® iR o ey g\

* Ferramenta de desenvolvimento: Quartus Il

Disponivel em: https://www.altera.com/support/software/download/altera_design/quartus_we/
dnl-quartus_we.jsp

— XLINX
* FPGA: Spartan-3 - XC35400
* Ferramenta de desenvolvimento: ISE
(versdo 8.1i: disponivel para download no site: www.xilinx.com)

14 krotol
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1.  Objetivo

O objetivo desta aula ¢ a familiarizacdo com o ambiente de desemvolvimento integrado -
Quartus IT da Altera — Vel'sﬁu-w'eb Edition. no Projeto de Sistemas Digitais ufilizando
PLDs (“Programmable Logic Devices” — Dispositivos de Légica Programadivel).
Utilizaremos o método de Captura de Esquematico para a descricdo do Projeto.

Além disso. pretende-se mosfrar que um Problema pode ser implementado através das
fungdes booleanas basicas. e conpreender o funcionamento de cada uma destas funcdes.

74
15 kroton®
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Esta aula apresenta uma breve introducdo a ferramenta de
desenvolvimento integrado Quartus Il da Altera — Versdo 14.0 Web Edition. Ela
d& uma viséo geral de um processo tipico de CAD (“Computer-Aided Design”
— Projeto Assistido por Computador) para projetar circuitos que sao
implementados usando dispositivos PLDs, e mostra como esse processo é
realizado no software Quartus Il. O processo de projeto utilizando o
software Quartus Il é ilustrado passo-a-passo através da implementacédo de
um circuito simples, em um dispositivo PLD da Altera.

O ambiente de desenvolvimento integrado Quartus Il da Altera inclui
suporte completo para todos os métodos mais populares de inserir uma
descricdo do circuito desejado em um sistema de CAD. Esta aula faz uso do
método de entrada denominado Captura de Esquemaético, no qual o usuario
desenha um diagrama grafico do circuito. O Ultimo passo no processo de
projeto envolve a programacgéo do circuito desenhado em um dispositivo
PLD real.

74
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Para mostrar como isso é feito, utilizaremos uma Placa Didatica de
Desenvolvimento — a DE2 - 115 da Altera — conectada a um computador que
tenha o software Quartus Il instalado. As telas apresentadas nesta aula foram
obtidas utilizando o Quartus Il da Altera — Versdo 14.0 Web Edition; se outras
versdes do software forem usadas, algumas das imagens podem ser
ligeiramente diferentes.

74
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2. Primeiros passos

Cada circuito l6gico que esta sendo projetado utilizando o “software” Quartus I
é chamado de Projeto. O “software” trabalha em um Projeto de cada vez e
mantém todas as informagdes daquele Projeto em um Unico diretério (pasta de
arquivos) no sistema de arquivos. Dessa forma, para comecar um novo Projeto
de um circuito loégico, o primeiro passo é criar um diretdrio para armazenar o0s
arquivos deste Projeto.

Iniciando o “software” Quartus I, uma tela semelhante & da Figura a seguir €
exibida. Esta tela é constituida de varias janelas (as quais séo selecionadas com
o0 mouse do computador) que ddo acesso a todas as funcionalidades do
“software” Quartus II.

74
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Barra de
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Dindmico
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Getting Started With Quartus® Il Software :%
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O Projeto

Sistema simples de alarme de automdvel para detectar, quando a Chave de
Ignicéo esta ligada, se o Cinto de Seguranga néo esta afivelado ou uma das
Portas est4 aberta.

— T

i D

/K Luz de Alerta para *1 ~—

:\/ Porta Aberta . -

Nz 2 e ST

N 75 =4 a SR
s S Luz de Alerta para
(02 Cinto de Seguranga e
T ) ¥
g S s kroton*

10



09/03/2015

A
Aula 2

Passo a passo

Iniciar um Novo Projeto

Para comecar a trabalhar em um projeto novo, primeiro temos que definir um
escopo para este projeto. O “software” Quartus |l facilita esta tarefa

fornecendo suporte na forma de um Assistente (“Wizard”). A criagdo de
um Novo Projeto segue as etapas detalhadas a seguir.

a) Selecionar File > New Project Wizard para iniciar o Assistente de Novo
Projeto o qual direciona a criacdo e configuragfes preliminares de um Novo
Projeto.

b) Na janela “New Project Wizard: Introduction”, clicar em Next.

21 kroton
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Janela “New Project Wizard: Add Files”. O Assistente de Novo Projeto
permite incluir arquivos pré-existentes (se houver) no Projeto.

Mew Projoct Wizard: Add Files [page 2 af 5] [S5=)

Seleat e deior il pou werk toincluds i e poject ChekAdd Al 10 23 o design e in e
et diaeions o ha progact. Mola: you can akusye 20 desgn e b #a pojeel Gle

Bienams | [l add

= rame Type Desgn HOL verson

add Al
_u |

.
Specilp the path names of any non-defeul Brarie: Lget Lieagies

2 kroton®
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Na janela “New Project Wizard: Family & Device Settings”:

f.1) Especificar o tipo de dispositivo no qual o circuito projetado sera
implementado.

No campo “Device Family — Family:”, escolher Ciclone IVE como Familia do
dispositivo de destino.

f.2) Pode-se deixar o “software” Quartus Il selecionar um dispositivo especifico
na familia, ou podemos escolher o dispositivo explicitamente. Utilizaremos esta
Ultima abordagem

No campo “Target device” escolher a opgao “Specific device selected in
‘Available devices’list”.

f.3) No campo “Available devices” aparece uma lista de dispositivos
disponiveis, escolher o dispositivo denominado EP2C70F896C6 que é um
PLD utilizado na Placa Didatica de Desenvolvimen

23 kroton
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Family & Device Settings [page 3 of 5]

&4 New Project Wizard

Select the family and device you want to target for compilation.
You can install additional device suppart with the Install Devices command on the Tools menu.

To determine the version of the Quartus II software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in 'Avaliable devices' list
Family: |Cydone Iv E - Package: [Any = ]
Devices: [Al ~ | Pincount: [any B3|
Target device Core Speed prade: [Any =
() Auto device selected by the Fitter Mame filter:
@ Specific device selected in "Available devices' list Show advanced devices
Other: nfa

Avaiable devices:

MName Core Voltage LEs User 1/0s Memory Bits Embedded multiplier 9-bit elements PLL +
EP4CE7SF2317 L 75408 293 2810880 400 4
EP4CE75F23I8L Lov 75408 293 2810880 400 4
EP4CE75F29C8 1.2V 75408 427 2810880 400 4
lEpacezsFaocy v [7sws ey lsmsso a0 ||
EP4CE75F29C8 L 75408 427 2810880 400 4
EP4CE75F29C8L Lov 75408 427 2810880 400 4
EP4CE75F29CSL Lov 75408 427 2810880 400 4 ‘_‘
EP4CE7SF2917 L 75408 427 2810880 400 4 I
EP4CE75F2918L 1oV 75408 427 2810880 400 4 ~
4 I »

<Back | [ Mext> |[ Finsh |[ cancel |[ heb |
i¢

24 kroton
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Resumo das Configuracdes escolhidas:

I R e A
New Project Wizard
4 New rect Waar

- -

Summary [page 5 of 5]

Project directory
Project name:
Toplevel design entity:
Number of fils added:
Number of user ibraries acded:
Device assignments:
Famiy name:
Device:
EDA tools:

Design entry/synthesis:

When you dick Finish, the project wil be created with the following settings:

C:\altera\14.0
aulal

aual

0

0

Cydone v &
EP4CETSF29C7

<None (<None>)

Simuiations ModelSim-Altera (VHDL)
Timing analysis: 0
Operating conitions:
VCCINT voltage: R
Juncton temperature range: o085 C
| | e [ .

Y
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€ QuartusI64-8it- Cvaltera/140/aulsl ~aulal W e

File  Edit

&

View Project Assignments Processing Tools Window Hep 5

T TR IR S E% e

Project Navigator 18 x

/A Cydone IV E: EPACE7SF29CT
> aulal &

Entity

o Hierarchy

Files I ;?Deilﬂ

[Tasks ra x|
Flow: I" '] [Cusinm'ze...]
Task

4 Compile Design
b Analysis & Synthesis
I> B Fitter (Place &Route]

QUARTUS® Il SOFTWARE v13.1:
GET THE COMPETITIVE EDGE WITH TH;
A O

25
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Para descrever o circuito no formato de Captura de Esquematico deve-se uwsar o Editor
Grafico do Quartus IL conforme as etapas detalhadas a seguir.

a)  Selecionar File > New para obter a janela da Figwa 14. Escolher “Block Diagram /
Schematic File” e clicar em OK. Isso abre a janela do Editor Grafico (Figural5).

o S =

+ it Qv || Poject
+ S0P Bukde) Systam
2+ Desun fiks

- AHOLFie

-EDIFFis
State Wachies Fie
SpabneabgHOAFin
Tel i Fle
Vi HEL Fis

| -WHOLFie

= MemenyFies
Havadecinal nlelFoma) Fil

- My I izaimFie

& Verbeolen Tieboggig Fle:

s S0 Pl
Logo Anakess Irieifase Fie
SigpalTap | Lacic Anabyocs Fla

- Vecho Waveom Fis

= Over Fiss

LIk Pl

- Black Symkol e

Chein Descriion Fie
S Duegn Coresrske: Pl
Ter Fie

[ ] e |

- |
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Fle Edt Vew Promct Assgents Processng Took Window hep D ‘Search altera, com ']
D@ 408 9o [am MY S FL O PP OO ET @D AP
|Project Navigator uux\ B Block LbdF [x] IP Cataiog A8 x
Enkty FEAGADE-OI1ANNSNOCON YA 24 d & k2@ 9~ Q, X =
Ay Cydore IV E: EPACEIF2CT . o T T . & »
= : N _‘m...u
+ Basc Functions
o5

Interface Protocdls
* Memory Interfaces and Contralers

- Processors and Peripherals
# library
Basc Functors
: o
: * Interface Protoceis
& ey [ Eles | # 0= 4)p + Mesmory Inerfaces and Controlers
Tadks a8x i @ search for Prtner
Flow:; |Complation = | [ customae... || ©

4 I Comple Deson
I anaiysis & Synthess
I Fitter (Place & Route)
1 Assentier (Generate prog] | *
# TimeQuest Tming Analysis
I EDA Mt Writer
B Frogram Device (CpenProrad | -
o (5

I 0] @ @ @) T < v
?rype 1D Message |
5 . i
2 e A romen
764,367 0% 00:00:00
28
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meiro passo é especificar um nome para o arquivo que serd eriado. Selecionar File

> Save as ... que abre a caixa de didlogo mostrada na Figura 16.

b.1)

No campo “tipo:” a opgdo Block Diagram/Schematic File (*. bdf) deve estar
selecionada.

O campo “name:” deve conter o nome do arquivo. o mesmo nome dado ao
arquivo que foi especificado quando o projeto fot criado.

A opgdo “Add file to current Project™ deve estar selecionada.

Clicar em “Salvar’. o que armazena o arquivo no diretdrio
C:\Alunosldula_02\Nome 122100010 ¢ leva a jancla do Editor Grafico exibida
na Figura 17.

G oot =)
saan [ lenezmon | +«EctEE
Esl Homé Medficade  Tips Tamanka
= FS
Lo ecarim
Deskiop
0
£
Compuadr
Fa
Home =]
p Biock: Cagrm/Schematic e b = Cancelar
(7 addtie 1o oummt project.
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€4 Quartus 164-8i - C/shera/14 0/aulal - aulal | jr——— — & -—w

Fle Edt Vew Pt ASSOWents Processng Toos Wndow heb D Search atera com @
IETT TR L2 1 T LI 2 LA X WL
[T — L] Skt o —

- JADE-OTITANNSOON Y |

Ay Cydore IV E: EPACEIF2CT — - -

> adal

4 B Comple Desgn
B Ansiysis &Synthess
B Fitter (Place & Route)

# TimeQuest Teming Anclyss
e EDA Hasist Writer

s esarcy | E|rles | Foed|n

Tadks a8x i
Flow: | Complation = | [ customae... || ©
Tesk

1 Assentier (Generate prog] | *

W Progran Davics (CpenPrograd |

Editor Grafico

Interface Protocdls
* Memory Interfaces and Contralers
 Processers and Peripherals

Basc Functns

# tibrory
Barra de ferramentas o
da janela do e Intetace Protocds

* Memory Interfoces and Controlers
@ sexrch for Partne

o i v b A

oA EE 7= - |
#lype 1D  Message
b +]
4 \ Systen /\ Proseseng / |
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O Editor Gréfico oferece uma série de bibliotecas que incluem elementos
de circuito que podem ser importados para um esquematico. Dé um duplo
cligue no espago em branco na janela do Editor Gréfico, ou clique no
icone na barra de ferramentas que se parece com uma porta AND .

1r

Va em “libraries”, em seguida, expandir a biblioteca “primitives”,
seguido de expansdo da biblioteca “logic” que compreende as portas
I6gicas. Selecione “and2”, que é uma Porta E de duas entradas, e clique
em OK. Agora, o simbolo da Porta E aparecera na janela do Editor
Gréfico. Usando o mouse, mova o simbolo para um local conveniente e
clique para colocéa-lo Ia. Importar a segunda

&

31
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€ Quartus 1 64-Bit - C/alvera/ 14 0/aulal - avlal - o =
2 tera.con ®
QS @ % 0@ i JHY S ¥¥ O PR DAL QB A 8D
Project hegater rax | @ Block bt [] P Cotnlog P x
Bxlty, FLrAGA@S-O 11 INANSYOONN P o 4/ WS & 228 9o Y X =
Af_wm“::"’“”m’ FE R TS R R T I “| 4 2 wotstec
- 4 Project Directory
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% symol [ | s
Lbrars: Functons
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—— o « Blge
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# b Compie Oeson B et 1
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B Fiter (Place 8 Roue) _—
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el W T
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Insert symbol a5 blodk.
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Figura 20 Importar os simbolos das Portas Logicas e organiza-los na janela do Editor
Grafico.
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Uma vez que os simbolos das Portas Légicas ja foram posicionados na
janela do Editor Grafico, agora é necessario introduzir os simbolos que
representam as Portas de Entrada e Saida do circuito. O procedimento é
0 mesmo para importar as Portas Ldgicas, mas escolhendo os simbolos
da biblioteca “Primitives/pin”. Importar duas instancias da Porta de
Entrada e uma instancia da Porta de Saida. O texto pode ser inserido
utilizando o icone da barra de ferramentas. @

Atribuir nomes para os simbolos de entrada e saida da seguinte forma.
Esteja certo de que nada esta selecionado clicando em um lugar vazio na
janela do Editor Grafico. Aponte para a palavra “pin_name” sobre o
simbolo do primeiro pino de entrada e dé um clique duplo com o mouse.
A caixa de dialogo “Pin Properties” No campo “Pin name(s):” digite o
nome do pino, Chave_lgnicao, e clique em OK. Da mesma forma,
atribuir, respectivamente, para os pinos da segunda e terceira entrada os
nomes Sensor_Cinto e Sensor_Porta, e Alarme para o pino de saida
Alternativamente, € possivel mudar o nome de um elemento
selecionando-o primeiro, e depois dando um duplo clique sobre o nome e,

em seguida, digitando um novo nome diretamente. &
34 kroton®
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Pin Properiies ﬂ

General ] Format |

To create nuitinle pive. enter a name in AHDL bus notation (for example.
Vnamel® O] or enter a comma-s=parsted list of names.

B name(s:  [Chave_|gnicac

Difauk value: [WEC |

Cancelar

Vamos acrescentar trés saidas intermediarias no circuito!!!

35 kroton

Pinos de Saida-do Circuito
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Compilar o Circuito Projetado

O arquivo do diagrama esquematico descrito — Luzes_de_Alerta.bdf, sera
processado por varias ferramentas do Quartus Il que irdo analisar o arquivo,
sintetizar o circuito, e gerar uma implementacgéo deste circuito para o chip de
destino. Estas ferramentas sao controladas pelo programa aplicativo chamado
Compilador.

Para executar o Compilador selecionar Processing > Start Compilation, ou
clicar no icone da barra de ferramentas horizontal.

-

A medida que a compilagéo passa pelos varios estagios, seu progresso
é relatado em uma janela no lado esquerdo da tela do Quartus Il (janela
“Tasks”). O sucesso (ou insucesso) do processo de compilagdo é
indicado em uma caixa de dialogo,

37 ‘kl’(‘)tOf\I(
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Etapas P6s-Complilagédo ficardo para a préxima aula!!!

Site para baixar o software Quartus e praticar a aula de hoje:
Software pesado em torno de 1,5Gb —torno de 5horas para baixar:
(Tem de fazer um cadastro antes!!!)

Link:

http://dl.altera.com/14.0/?edition=web

74
38 kroton®
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»Download Center ) Documentation & myAltera Account

Devices  uDesign Tools & Services| M End Markets 3 Technology N Training username: [ | & .

Design Software
Quartus IT Subscription Edition

Quartus IT ¥ n
MegaCore IP Library
Model -Altera

ModelSim-Altera Starter
Nios 11 EDS Legacy Tools
DSP Builder

Altera SDK for OpenCL
0S Support

Embedded Software
SoC RTOS Support
SoC EDS

Archives
Service Packs
Design Software

Licensing
Get and Manage Licenses
Licensing FAQ

License Daemon Software

Programming Software
Quartus IT Programmer
Jam™ STAPL Software

Drivers
Cable & Adapter Drivers

Board System Design
INEye

SPICE Models

18IS Models

Pawer Distribution Network

Quartus Il Web Edition & Remember me
Forgot my username or password

Home > Suppart > Downloads > Q

Don't have myAltera account? Register Now.
Release date: June, 2014 Enter your email address:

Latest Release: v14.0

Seledt relzase:

—~
A QUARTUS"H

2 Linux

Operating System @ | A Windows

Download Method @ ® akamai DLM3 Download Manager @ © Direct Download —

+ The Quartus 11 software version 14.0 supports the following device families: Arria 11, Arria v, Cyelone 1, Cyclone
W, MAX TI, MAX V, Stratix IV, and Stratix V.~ More

——— 1
comtine rics |[FROIONER 0.5 .| paonat sorowers | Uptates |

Download and install instructions: - More
Read Altera Software v14.0 Installation FAQ

uartus IT Web Edition (Free)

uartus TI Software (includes Nios IT EDS)
Size: 1.1 GB MDS5: 7418921EQ0FSBEABT4AAADB5324E8882 URDATE
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